Signet 4630 Chlorine Analyzer System English

3-4630.090 Rev E 5/11 English

CAUTION!

1. Follow instructions carefully to avoid personal injury.

2. Do not exceed the maximum pressure or temperature

specifications.

3. Mounting the Chlorine System in an outdoor box, in areas with
elevated temperatures, may cause damage to the system if
the enclosure's internal temperature exceeds the temperature
specification of the Chlorine Analyzer.

Do not alter product construction.

For use with clean fresh water only.

Disconnect AC power before opening wiring enclosure.

This panel system uses AC voltages. Wiring should be done by
qualified personnel only.
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1. 4630 Chlorine Analyzer System Inventory

1. Chlorine panel assembly
a. Built-in pressure regulator 15 to 120 psi.
b. 3/8 inch hose barb connectors.
2. 1 each 3-2630-2 Free Chlorine sensor with protective cap
a. 1 spare membrane cap
b. 1 bottle of electrolyte solution
c. 1 syringe needle (taped to bottle)
d. 1 syringe
1 each Flat pH sensor 3-2724-00 (159 001 545) (3-4630-21 model only)
Manual package
a. English panel assembly manual
b. CD with multi-language manuals
c. Wall mounting hardware
d. Drill template
5. 1 each North American Type B power cord
6. Customer supplied
a. 3/8" hose input and drain
b. Hose clamps

B w

2. Quick Start Up Guide

Follow the steps below to set up a new Chlorine Analyzer System. Refer to the individual component manuals for detailed information.

( )
Step 1. Mount the panel on a vertical flat surface using appropriate hardware.

A Do not turn on power at this time.

Step 2. Open the wiring enclosure and wire input power (see section 8 and 8.1: Wiring Inputs/Outputs).
Step 3. Wire any 4 to 20 mA and relay output.

Step 4. Remove sensor access plugs from the flow cell (Figure 1). If the optional pH sensor is NOT used,
do not remove remove the left-side plug from the flow cell.

Step 5. Install sensor into the electronics (see section 10: Sensor Installation). Chlorine sensor is installed in the right-side
access port, optional pH sensor is installed in the left-side access port.

Step 6. Remove the protective cap from the electrode tip and install the electrode into the flow cell.
(Keep the electrode tip cap in a safe place for future use. It is recommend to use the cap to protect the
sensor during the removal of the electrode for cleaning or maintenance of the flow cell).

NOTE: All new chlorine and pH sensors require calibration during the start up of a system and also throughout the life of the sensor.
A new chlorine sensor requires a 4-hour conditioning period with power on and water flowing past the sensor prior to
calibration. Refer to section Il, section 7 for chlorine calibration and set up procedure.

NOTE: If optional pH sensor is not being used, pH must be "hard-coded" into the system. Refer to section Il, section 5.3 for manual
pH compensation. If optional pH sensor is installed, refer to section Il, section 5 to calibrate pH electrode.

Step 7. Repeat step 5 and 6 if the optional pH sensor is being used.

Step 8. Install the influent water source to the "Inlet Port" nipple assembly of the flow cell. Install 3/8 inch tubing and secure
with a hose clamp. (Not included. See section I, section 10) e"n

]
Step 9. Install 3/8 inch tubing and secure with a hose clamp on the "Drain" port 1
and direct the tube to a proper drain. (Not included. See section I, section 1
10) Sensor access plugs v

t i (B v ¢

1 -1 - LR

Step 10. Verify the inlet and drain ball valves are in the open position and the (\? T‘— =

sample port is in the off position (See section I, section 11: Tubing - :

Connections). @ I /

|

Step 11. Turn on the influent water source and check the system for leaks. O . ! '!' ‘?
Step 12. Apply power to the system, and allow system to initialize. Calibrate per S

instructions (See section I, sections 5 and 7). !

Figure 1
_ _J
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3. Description

The Signet Chlorine Analyzer System is an integrated, all-in-one chlorine panel system designed to measure free chlorine in
drinking water and clean fresh water treatment applications.

-~

Features:

+  Complete chlorine analyzer system allows quick setup and easy installation.
Connect to a water source and plug it in.

* Unique integrated clear flow cell combines sensors, flow regulator, filter and
variable area flow indicator in one compact unit.

»  Built-in variable area flow indicator facilitates flow rate confirmation at a
glance.

» Integrated flow regulator with removable filter accepts inlet pressures of 1 to
8 bar (15 to 120 psi) while maintaining constant flow and minimal pressure
to the sensors.

*  Water flows vertically into sensor tip, eliminating bubble entrapment. Raised
exit in flow cell sensor chamber ensures sensors stay submerged even
when system and flow is turned off.

*  Flow cell accommodates two sensors; one chlorine and an optional pH
Sensor.

*  Automatic pH and temperature compensation or manual pH value input
capability for chlorine reading accuracy.

«  Easy viewing of the transmitter via the bright backlit LCD display.

*  Moisture proof NEMA 4X wiring enclosure.

Additional information can be found in the individual product manuals, refer
to www.gfsignet.com. Click on Product Manuals under the Signet Quick Links
section.

»  8630-3P Chlorine Transmitter Manual

*  2630-2 Amperometric Chlorine Electrode Manual
* 2650 Amperometric Electronics Manual

* 2724 pH/ORP Electrode Manual

e 2750-7 pH Electronics Manual

4. Dimensions
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5. Panel Assembly

@

Wiring enclosure

Transmitter
3-8630-3P (159 001 673)

Power cable conduit — — Output conduits

Amperometric chlorine

sensor electronics
3-2650-7 (159 001 670)

pH sensor

electronics
3-2750-7 (159 001 671)

Chlorine electrode
3-2630-2 (159 001 662)

pH electrode
3-2724-00 (159 001 545)

Flow range limits 4 ‘

Flow rate indicator —jsg—

—— Flow cell block

Flow cell O-rings

Flow regulator with strainer Q’&j

Inlet port —— ' - 3/8" Ball valve
4300-5225*

]

Quick disconnect —A __ 3/8"Hose barb
2000-2525* p’ 2000-3804*
Draln port
(3/8 inch hose)
Quick disconnect plug Sampling port
(3/8 inch hose)

2000-3825*

* Contact factory for quote
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6. Component Identification: Flow Cell

Flow cell nut

Flat washer
H‘—’ — Flow cell back block
it
& ——» ——— Spacerring
«» —— — Stainless steel filter | Regulator Assy

(3-4630.391)
Pressure regulator

Pressure regulator outer O-ring (large)

Pressure regulator outer O-ring (small) | Flow Cell Rebuild Kit
(3-4630.390)
—— Flow cell O-rings (4 segments) 4-4630.392

| — Flow cell front block

_— Flat washer

==

= —— Disc spring (2700-0003)*
— Knurled thumb nut (1700-2512)*

Flow cell bolt (2490-0554)

*Not included with
3-4630.392

Included in kit 3-4630.390
Flat washer Item Quantity
Flow cell nut 6
Disc spring (curved washer) Flat washer 15
Disc spring 9
Knurled thumb nut 3
Flow cell bolt 6

4630 Chlorine Analyzer System +GF+



7. Mounting

Indoors is recommended.

Mount the panel according to local electrical, building, and or plumbing codes and seismic
requirements.

The panel must be mounted vertically in an upright position.

Use four 6 mm (4 in.) diameter screws or bolts of sufficient length to mount the panel to a sturdy
vertical surface. A mounting template is provided.

Allow clearance on the sides and bottom for service to the unit.

Bright light can promote algae growth.

Keep panel system electronics and enclosure away from dripping water.

If the system is mounted outdoors, an outdoor enclosure for the whole system must be used to
protect the electronics and flow cell from light, rodents, insects and dirt.

A Mount out of direct sunlight.

6 +GF+ 4630 Chlorine Analyzer System



8. Wiring Input

WARNING

This panel system is wired for AC voltages that can injure
or kill. Wiring should be done by qualified personnel only.
Disconnect AC power before opening wiring enclosure.

Follow all local and government recommendations and methods for installation of
electrical connections to and between the system and other devices.

System Input Power 4 \
. . . I 100 to 240 VAC input
*  The panel system is pre-wired with an auto switching power supply Standard AC configuration
that is rated for 100 to 240 VAC 50/60 Hz input. ;:
*  Wire with NEC Class I, 300 volt, 105 C wire. u@‘ ~

*  Aswitch or circuit breaker rated at 15 amps AC shall be included in
the building installation.

* Install the circuit breaker in close proximity to the equipment and
within easy reach of the operator.

*  Mark the circuit breaker as the disconnecting device for the
equipment.

Part # 7300-0024 shown. Actual power supply may differ from Figure 2.

100 to 240 VAC Input Wiring

W

&

Input for

100-240 VAC Figure 2

*  Open the electrical box by loosening the four corner screws of the
front cover. \ Y,
* Insert input power wiring into the pre-drilled access hole on the left
side of the electrical box using the appropriate conduit adapters to
maintain the Type 4X rating. (Customer may have to remove the
supplied conduit connectors.) (" A
* Install the input power wires into the proper terminals on the power
supply (Figure 2). Use only 12-26 AWG copper wiring.
«  Recommended torque for the terminals is 7 Ib-in.

NOTE: When using alternate power supply 7300-7524:
*  Use 10-24 AWG copper wiring, 105°C, torque 4.4 Ib-in.

12 to 24 VDC Input Wiring Conversion

» If the power source supplied to the system will be 12 to 24 VDC
instead of 100 to 240 VAC, disconnect the red and black output wires
from the power supply (Figure 3) and connect your DC power source
to them (Figure 4).

* Insert input power wiring into the pre-drilled access hole on the left g
side of the electrical box using the appropriate conduit adapters to \ )
maintain the Type 4X rating. (Customer may have to remove the
supplied conduit connectors.)

»  Aswitch or circuit breaker rated at 5 amps DC shall be included in
the building installation.

* Install the circuit breaker in close proximity to the equipment and
within easy reach of the operator.

*  Mark the circuit breaker as the disconnecting device for the
equipment.

Figure 3

Power Supply Terminal Identification

Terminal | Name Description

V. ADJ | Voltage adjustment | Adjusts within £10%; turning clockwise
increases output voltage

DC ON | Operation indicator | Green LED is lit when output voltage
is on

+V, -V DC output terminals | +V: Positive output terminal
—V: Negative output terminal

Figure 4

L, N Input terminals Accepts a wide range of voltages \_
and frequencies (100 to 240 VAC DC
input)
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8.1 Wiring Output

Follow all local and government recommendations and methods
for installation of electrical connections to and between the
system and other devices.

Output Connections

WARNING

This panel system is wired for AC voltages that can injure
or kill. Wiring should be done by qualified personnel only.
Disconnect AC power before opening wiring enclosure.

Use the wiring enclosure terminal block for output wire
connections. Do not wire directly to the transmitter.
Recommended torque for the terminals is 7 Ib-in

Do not run 4 to 20 mA loop cables in the same conduit as the
power or other high voltage wiring.

Remove one installed jumper wire (from both of its terminals)
on the terminal block in the enclosure for each loop device
connected. Replace the jumper if you later remove your loop
device. If only one loop device is connected, remove just one Jumper wire removed
jumper wire from its two terminals.

The panel system uses an active loop output wired to the
enclosure terminal block.

If connecting to a PLC, use the PLC's passive input.

The transmitter must have a jumper wire or loop device
always connected to Loop 1.

Wiring Label Legend

Earth Ground. Attach 4 to 20 mA loop cable

Ground shield wire here to help eliminate possible noise.

Loop 1 4 to 20 mA Loop #1

Loop 2 4 to 20 mA Loop #2

Relay 1 Relay Output #1

Relay Normally Closed when un-energized

NC (contact)

C Common

Relay Normally Open when un-energized (no

NO contact)

Relay 2 | Relay Output #2 (terminals same as Relay #1)

Wiring a 4 to 20 mA loop device

PLC Terminals
+| Channel1
- 4t020 mA

+| Channel 2
- 4to 20 mA

GROUND
LOOP 1

LOOP 2

RELAY 1

RELAY 2

PLC dual channel connection

+GF+
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Electrical Box Wiring Schematic
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10. Sensor Installation

Remove applicable sensor access plugs from the flow cell (pg. 2, Figure 1). Holding the 3-2750-7 or 3-2650-7 electronics
inverted, open the DryLoc® connector by turning the upper locking ring Ya-turn counter-clockwise. Insert the electrode facing
up. Turn the locking ring a-turn clockwise to lock the electronics in place. The mechanism will “click” when it is locked. Install
the complete assembily into the flow cell and ensure the key on the electrode aligns with the key slot on the flow cell.

DryLoc® Connection to Sensor Electronics

3-2724-00 3-2630-2
FCL electrode

pH electrode

Locking Ring Locking Ring
Lock
3-2750-1 3-2650-7
Amperometric Electronics

pH electronics

4630 Chlorine Analyzer System
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11. Tubing Connections

*  Use suitable 9.5 mm (3/8 in) ID tubing that is rated for your inlet pressure.

Use hose clamps.

Inlet Quick Release Connection

Press down gray plunger to release. Water flow
is automatically shut off when disconnected.

Valve position for start up and normal use.

Note: Turn off inlet valve first when stopping water
flow.

» The drain tube must be positioned lower than
the influent water source to allow proper flow

through the flow cell. The flow cell must drain by
gravity, not system pressure.

12. Water Flow

Flow Rate

The flow rate is in the proper range when the float is between the Min. and Max. markers on the flow cell. The flow range limits are
30.24 t0 45.36 L/h (8 to 12 gal/h).

4630 Chlorine Analyzer System

Inlet

Drain Sampling port
(to atmosphere) (flow off)

+GF+
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For Low Flow applications (flow less than 1 bar/15 psi),

the Flow Regulator can be removed and the flow

adjusted using the Flow Cell ball valve. (NOTE: The
inlet hose barb will also need to be changed. Contact
factory for details.)



Section Il - 8630 Chlorine Transmitter

1.

CAUTION!
Remove power to unit before wiring input or output connections.
Follow instructions carefully to avoid personal injury or damage to the transmitter.

The View Mode

The View Menu is displayed during normal operation.

To select a VIEW display, press the UP or DOWN arrow keys. The selections will scroll in a continuous
to view.

Changing the VIEW display does not interrupt system operations.

No key code is necessary to change display selection.

Output settings cannot be edited from the VIEW menu.

All menus time-out after 10 minutes and return to the previous operating display.

When editing the CALIBRATE or OPTIONS menus, the transmitter will return to the non-edit

display after 10 minutes and then the VIEW menu in another 10 minutes if no activity occurs.

-
~

-

4

AY
AY
\

FCl: 2.67 ppm
7.10 pH 25.3 °C

FCI = free chlorine.

example View menus below return to the default display after 10 minutes

Transmitter Editing Procedure

The 8630-3 has two menus the user can edit; CALIBRATE and OPTIONS.
The CALIBRATE menu allows you to calibrate and initialize sensors, define current loops and set relay
The OPTIONS menu allows you to set sensor type, adjust and test current loops, test relays and more.

loop. There are four pages

View chlorine, pH and temperature values from the sensor.

Cl Raw: 103.8 nA | Chlorine (nA) and pH raw (mV) signals from the sensors.
pH Raw: -5.9 mV For reference only.
Loop 1 10.68 mA .
Loop 2 8.56 mA View of current loop 1 and loop 2 output.
1
Last CAL: . I . . .
10-18-10 View of the last calibration date. Editable in the Calibrate Menu.

functions.

Press and hold the ENTER key:
» 2 seconds to select the CALIBRATE menu.
» 5 seconds to select the OPTIONS menu.

Enter the Key Code.
The Key Code is UP-UP-UP-DOWN keys in sequence.

Scroll the menu in a loop with the DOWN or UP arrow keys.

Press the RIGHT ARROW key to select the menu item to be edited.
 The first display element will begin flashing.

Press the UP or DOWN keys to edit the flashing element.
* The RIGHT ARROW key advances the flashing element.

Press the ENTER key to save the new setting and return to Step 3.

« After entering the Key Code, the display will show the first item in the selected menu.

\

Press the UP and DOWN keys simultaneously
while any element is flashing. This will recall the
last saved value of the item being edited and will
return you to Step 3.

Made an Error? Finished Editing?

U

Press the UP and DOWN keys simultaneously
after saving the last setting to return to view menu. ‘2

12
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2.1 Example: Calibration

Access the CALIBRATE Menu:
The CALIBRATE and OPTIONS menus require a KEY CODE.
Press and hold the ENTER key for 2 seconds to access the
CALIBRATE menu.

u Enter the Key Code:
Pressing the UP, UP, UP, DOWN keys in sequence unlocks the
display and the first menu item will appear. If no key is pressed
for 5 minutes while the display is showing "Enter Key Code", it will
return to the VIEW menu.

K2 scroll the Menu:
Press the DOWN or UP keys to scroll through the Menu.
Refer to pages 3 and 4 for complete listing of these items.
While in this mode, pressing the UP and DOWN keys
simultaneously will return the display to the VIEW menu.
If no key is pressed for 10 minutes, the display will return to the
VIEW menu.

u Select the item to be edited:
In this example, "Last Cal" (last calibration date) is chosen to edit.
Pressing the RIGHT arrow key selects the menu item and enters
the screen into edit mode.

B Edit the flashing element:
This is the edit mode.
The UP or DOWN keys change the flashing element.
The RIGHT arrow key advances the flashing element in a
continuous loop. In this example, the "Last Cal" date was
changed from 09-18-09 to 10-18-09.
All output functions remain active during editing.
Only the flashing element can be edited.

When you have set your desired value, pressing the ENTER key
stores the value on the screen, making it immediately available to
output functions and exits you back to Step 3.

CALIBRATE menu

CALIBRATE:----
Enter Key Code

CALIBRATE: ---
Enter Key Code

CALIBRATE: - -
Enter Key Code

CALIBRATE:
Enter Key

Code

Cl Zero
Calibration: >

2\

Cl Zero
Calibration: >

4 Y

Last Cal:
09-18-09 >

\/Example

Last Cal:
09-18-09 >

Last Cal:
09-18-09

Last Cal:
19-18-09

Last Cal:
19-18-09

Last Cal:
10-18-09

Last Cal:
Saving

Last Cal:
10-18-09

% OPTIONS menu

-

N e e = = = = = = = = = = ==

Made an Error?
Press the UP and DOWN keys simultaneously

Finished Editing?

Press the UP and DOWN keys simultaneously

while any element is flashing. This will recall the after saving the last setting to return to the View
last saved value of the item being edited and Menu.
return you to Step 3.
[ 1]
4630 Chlorine Analyzer System +GF+ 13



3.

Calibrate Menu Definitions

The menus below are displayed here in the order seen when scrolling down through the Calibrate Menu.

NOTE:
For greater accuracy it is recommended that the initial calibration of the system in the following order

4

14

1.
2.

3.

Temperature

pH electrode (if optional pH sensor is purchased. If manual pH sensor is selected enter the pH value into the option
menu prior to calibrating the chlorine sensor)

Chlorine sensor

Although the Calibrate Menu can be navigated upwards or downwards, it is best to navigate downwards when editing
Current Loop and Relay settings as previous entries can influence subsequent menus.
Chlorine and pH calibration screens will be shown only when a valid sensor is detected.

Press the Up or Down Arrow u Press the Right Arrow key to enter gl Press the Enter key to save your

key to scroll through the menus

edit mode settings

Calibrate Menus

- Factory settings shown -

Description

Chlorine Units:

ppm >
Cl Zero

Calibration: >
Cl In Process
Calibration: >
Reset Cl to
Factory Cal: >
Cl Temperature
Calibration: >

This is the first screen. Choose units of measurement of ppm or mg/I.

When > is pressed, the “live” readings are shown. The nA value is displayed, but cannot be
edited and is used for diagnostic and calibration purposes. When in Edit Mode, pressing Enter
stores the displayed value as your zero reference. Example on Section 15.

Enter process chlorine value determined from a DPD test kit here. Example on Section 15.

This menu resets Cl readings, Zero Calibration and temperature back to Factory Calibration.
WARNING! User entered ClI calibration settings will be lost.

Enter process temperature from a reference thermometer: °C or °F. Units are set up in the
Options Menu. Example on Section 15.

NOTE: The next two pH calibration screens will be shown only when a valid pH sensor is detected.

pH Standard

Set pH offset value. This applies a linear offset to the pH measurement.
Example on Section 13.

Applies a slope to the pH measurement. The slope and standard value must be at least 2 pH
units apart. Example on Section 13.

Reset pH standard, slope or back to Factory Calibration.
WARNING! User entered pH calibration settings will be lost.

Current Output Functions

Calibration: >
pH Slope
Calibration: >
Reset pH to
Factory Cal: >
Loop 1 Source:
Chlorine >

Loop 1 Rng: ppm

0.00 > 5.00 >
Loop 2 Source:

pH >
Loop 2 Rng: pH

00.0 ->14.00 >

Choose chlorine or pH for this 4 to 20 mA current loop. Example on Section 16.

Select the minimum and maximum values for the current loop output. Units are derived from
Loop 1 Source. If the Source 1 is changed, be sure to re-edit this page.

Choose pH or chlorine for this 4 to 20 mA current loop.

Select the minimum and maximum values for the current loop output. Units are derived from
Loop 2 Source. If Source 2 is changed, be sure to re-edit this page.

+GF+ 4630 Chlorine Analyzer System




Calibrate Menu - continued

Relay Functions

! Verify all relay settings if the Relay Source is changed.

Relay 1 Mode:
off >

If Low or High Mode was chosen:

Choose mode of operation: Off, Low, High, Window, or Pulse. If Off, all subsequent Relay 1
functions are inactive and not visible. Example on Section 16.3.

Relay 1 Source:

Chlorine >
Relay 1 Setpnt:
0.00 ppm >
Relay 1 Hys:
0.20 ppm >
Relay 1 Delay:
0.0 secs >
If Window Mode was chosen:
Relay 1 Source:
Chlorine >
Relayl Rng: ppm
0.00 > 5.00 >
Relay 1 Hys:
0.20 ppm >
Relay 1 Delay:
0.0 secs >
If Pulse Mode was chosen:
Relay 1 Source:
Chlorine >
Relayl Rng: ppm
0.00 > 5.00 >
Relayl PlsRate:
120 pulses/min >

Relay 2 Mode:
off >

If Low or High Mode was chosen:

Choose chlorine or pH for Relay 1.

In Low or Hi Mode, Relay 1 will be activated when the process reaches this value.
Units of measure reflect Relay 1 Source.

Relay 1 will be deactivated at Relay 1 Setpoint + this hysteresis setting depending on
High or Low Setpoint selection.

Set the time delay for Relay 1 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

Choose chlorine or pH for Relay 1.

Enter the range where Relay 1 will activate above and below this setpoint.

Relay 1 will be deactivated at Range setpoints + this hysteresis setting.

Set time delay for Relay 1 to activate after reaching the setpoints set in Relay 1 Range.

Choose chlorine or pH for Relay 1.

Enter the range where Relay 1 will activate above and below this setpoint.

Set the maximum pulse rate. Range: 1 to 400 pulses/min.

Choose Relay 2 mode of operation: Off, Low, High, Window, or Pulse.
To disable this relay choose Off.

Relay 2 Source:

pH >
Relay 2 Setpnt:
0.00 pH >
Relay 2 Hys:
0.20 pH >
Relay 2 Delay:
0.0 secs >

4630 Chlorine Analyzer System

Choose pH or chlorine for Relay 2. This menu screen and all subsequent Relay 2
screens below do not appear if Relay 2 Mode is set to Off.

In Low or High Mode, Relay 2 will be activated when the process reaches this value.
Units of measure reflect Relay 2 Source.

Relay 2 will be deactivated at Relay 2 Setpoint + this hysteresis setting depending on
High or Low Setpoint selection.

Set the time delay for Relay 2 to activate after reaching the Setpoint.
Range: 0 to 6400 seconds.

+GF+
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Calibrate Menu - continued

If Window Mode was chosen:

Relay 2 Source:
pH

Relay 2 Rng: ppm
0.00 > 5.00 >

Relay 2 Hys:
0.20 ppm >

Relay 2 Delay:
0.0 secs >

If Pulse Mode was chosen:

Relay 2 Source:
pH

Relay2 Rng: pH
0.00 > 14.0 >

Relay2 PlsRate:
120 pulses/min >

Find New
Sensor(s): >

Last Cal
10-18-09 >

Choose pH or chlorine for Relay 2.

Enter the range where Relay 2 will activate above and below this setpoint.

This relay will be deactivated at Relay 2 Range setpoints * this hysteresis.

Set the time delay for Relay 2 to activate after reaching the setpoints set in the
Relay 2 Range.

Choose pH or chlorine for Relay 2.

Enter the range where Relay 2 will activate above and below this setpoint.

Set the maximum pulse rate. Range: 1-400 pulses/min.

Required only when a new sensor is changed while the power is on. Choose Yes or No.

Edit the calibration date.

End of Calibrate Menu

4. Options Menu Definitions

16

% OPTIONS menu

Press the Up or Down key to u Press the Right Arrow key to enter i} Press the Enter key to save your

scroll through the menus

edit mode settings

Options Display

(Factory settings shown) Description
Contgast: S Adjust the LCD contrast for best viewing. A setting of 1 is lower contrast, 5 is higher.
Cl Sensor Type: Select the chlorine sensor: Free Cl.
Free Cl1 >
pH Input Choose Manual or Sensor. If Sensor is chosen, the pH value from the connected pH sensor will
Sensor > | be used. Choose Manual to enter a pH value manually when no sensor is connected.

If Manual pH input was chosen:

Manual pH Value
7.000 pH

Temp Display:
°C

Enter your pH value here if a pH sensor is not connected.

> Choose units of °C or °F.

Averaging: OFF gives the fastest response to input changes. LOW = 4.5 seconds, HIGH = 9 seconds of
off > | averaged response. Increase averaging to steady the display.

+GF+ 4630 Chlorine Analyzer System




Options Menu - continued

Options Display

(Factory settings shown)

Description

Decimal:

Fkk Ak >

Loop 1 Adjust:

4.00 mA >

Loop 1 Adjust:

20.00 mA >

Loop2 Adjust:

4.00 mA >

Loop2 Adjust:

20.00 mA >

Test Loop 1:

>
Test Loop 2:
>
Test Relay 1:
>
Test Relay 2:
>
Read Sens Data:
No >

If Yes was chosen:

Cl Sensor S/N:
XXXXXXXXX

Cl Type & Range:
2630 XXX.X ppm

Zero Cal: ppm&nA
XXX o XX XXXX . X

In Proc: ppm&nA
XXX« XX  XXXX.X

Temp at Cal:
XXXX.X °C

pH at Cal:
XXX .XX pH

Temp Offset:
XXXX.X °C

Elapsed Time:
XXXxX. hrs

Low & High: °C
SXXXX. X HXXXX . X

Select the decimal point for the display. Maximum of 2 decimal places.

Adjust the minimum current output for Loop 1. The display value represents the precise
current output. Range: 3.80 mA to 5.00 mA.

Adjust maximum current output for Loop 1. Range: 19.00 mA to 21.00 mA.

Adjust the minimum current output for Loop 2. Range: 3.80 mA to 5.00 mA.

Adjust maximum current output for Loop 2. Range: 19.00 mA to 21.00 mA.

Press UP or DOWN keys to manually output any current value from 3.6 mA to 21.00 mA to
test Loop 1 output.

Press UP or DOWN keys to manually output any output current value from 3.6 mA to
21.00 mA to test Loop 2 output.

Press UP or DOWN keys to manually toggle Relay 1 Off and On. The left LED on the front
of the transmitter confirms operation.

Press UP or DOWN keys to manually toggle Relay 2 Off and On. The right red LED on the
front of the transmitter confirms operation.

If "YES" is selected the following (Read Only) screens will be shown.
If "NO" then this menu ends the Options Menu.

View the sensor serial number.

Identify the chlorine sensor type connected and its ppm range.

View user entered Zero Calibration data in ppm and nA.

View user In-Process Calibration value when it was entered in the Calibrate Menu.

Temperature recorded during user In-Process Calibration.

pH value recorded during user In-Process Calibration.

Temperature offset calculated from user entered temperature calibration from Calibrate Menu.

Total hours of operation.

Lowest and highest temperatures the Cl sensor has been subjected to during operation.

4630 Chlorine Analyzer System

End of Options Menu
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5. pH Sensor Calibration

System Start-up: Step 3

If a pH sensor is part of the system, use the GF Calibration Kit 3-2700.395 (159 001 605) prior to initially installing the sensor and
during its normal lifetime. If a pH sensor is not available but pH determination is necessary, measure process pH with a separate
test and enter the value in the Options Menu. Next step: Chlorine Sensor Conditioning (see section 6, page 24). )

Refer to your pH sensor manual.

The pH sensor needs to be calibrated against two different pH
buffer references to calibrate the offset (standard) and slope.

Electrode offset is any deviation from 0 mV in a pH 7 buffer at 25 °C.

Slope is the ratio of mV to pH units.
. Always keep any output devices offline when calibrating.

5.1 pH Offset (Standard)

The transmitter must be powered on and the pH sensor must be

connected.

1. Turn off the water flow through the system, then remove the
pH sensor from its flow cell.

2. Using pH buffer 7.0, place enough pH buffers into a
clean calibration cup, supplied with the pH calibration kit
3-2700.395 (159 001 605), to cover the tip of the electrode.

3. Pour distilled water in another clean cup for rinsing the
electrode between buffers

4. Rinse probe, place the pH sensor in the pH 7.0 buffer and
allow the mV reading to stabilize.

Example: Set pH Standard to 7.00.

Go to the Calibrate Menu.
Scroll down ¥ 5 menus to the pH Standard menu.
Press » to enter Edit Mode.
Enter the pH value of the buffer that the electrode is placed
in; 7.00 in this case.
Press the Enter button to save the setting.
0.| Exit to the View Menu.(A V)

L

ONoo

= ©

FCl: 2.67 ppm View Menu
Stepd | 2771 pH 25.3°C

6 pH Standard
Calibration: >

7 B

8 pH Standard Cal:
07.00 pH/ © mV

v
/ ENTER|

pH buffer value

entered here u n

1

Calibrate Menu

5.2 pH Slope

1.  Remove the pH sensor from the first buffer solution and rinse
it in distilled water.

2. Place the pH sensor in a different buffer solution (example:
pH 4.01). The pH standard and slope must be at least 2 pH
units apart.

3. Note the pH and mV readings on the View Menu and allow it
to stabilize.

Example: Set pH slope to 4.01.

Scroll down ¥ 1 menus to the pH Slope menu.

Press » to enter Edit Mode.

Enter the pH value of the buffer that the electrode is placed
in; 4.01 in this case.

Press